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• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html
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http://h20230.www2.hp.com/new_access_levels.jsp
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1 Managing HP-UX Virtual Servers Using Server 
Automation
The chapter has the following sections:

• Introduction

• Viewing Summary, Hardware, and ioScan Information

• Configuring Server Timeouts

• Managing vPars Containers

• Managing HPVM Hypervisors

• Managing vSwitches

• Troubleshooting

Introduction

SA provides a web extension to create and manage virtual HP-UX machines (HP-UX Virtual 
partitions and HP Integrity Virtual machines) through SA. This extension is described in this 
user guide.

For more information on virtual machines and related topics, see the SA documentation at: 

http://support.openview.hp.com/selfsolve/manuals

Definitions

• HP-UX Virtual Partitions (vPars containers) - vPars containers enables you to run 
multiple instances of HP-UX simultaneously on one hard partition by dividing that hard 
partition further into virtual partitions. Each virtual partition is assigned its own subset 
of hardware, runs a separate instance of HP-UX, and hosts its own set of applications. 
Because each instance of HP-UX is isolated from all other instances, vPars provides 
application and operating system (OS) fault isolation. Each instance of HP-UX can have 
different patches and a different kernel.

• HPVM Hypervisors - HPVM hypervisors are soft partitioning and virtualization 
technologies that provides operating system isolation, with sub-CPU allocation 
granularity and shared I/O. HPVM hypervisors can be installed on an Integrity server, 
Integrity server blade, or hardware partition (nPartition) running HP-UX. The HPVM 
hypervisor environment consists of two types of components:

— HPVM Host

— Virtual machines (also called guests)

• HPVM Hypervisor Host (Host) - The HPVM hypervisor host virtualizes physical 
processors, memory, and I/O devices, allowing you to allocate them as virtual resources to 
each virtual machine.
3

http://support.openview.hp.com/selfsolve/manuals
http://support.openview.hp.com/selfsolve/manuals


• HPVM - Individual virtual machines, components of the HPVM Hypervisor.

• vPars - Individual vPars, components of the vPars Container.

• vSwitches - Virtual switches.

Audience

This document is written for system administrators who use Server Automation to manage 
HP-UX virtual servers.

Requirements

The following are requirements for this feature:

• For both vPars and HPVM hypervisors:

— Make all host servers (HP-UX servers) managed servers on HP Server Automation.

• For vPars:

— Install the Virtual Partitions product on the host server. See “Virtual Partitions” in: 
http://docs.hp.com/hpux/11iv3.

• For HPVM hypervisors:

— Install the HP Integrity Virtual Machine product on the host server. See “HP Integrity 
Virtual Machines and Online VM Migration” in: http://docs.hp.com/hpux/11iv3.

Supported Platforms and Configurations

Managing HP-UX virtual servers using SA supports the following platforms and 
configurations:

Table 1 Supported Platforms and Configurations

Platform or Configuration Support

Virtualization Platforms vPars A.5.06 and later versions

HPVM hypervisors 4.2 and later versions

HP-UX guest OS 11iV3

HP-UX Host OS for IVM and first vPars on 
physical server

11iV3

Processor Architecture Itanium

SA Version 9.04 CORD release

SA platform RHEL AS4 – 64bit

Satellite and Multi-master support RHEL AS4 – 64bit

Integrity platform support As defined by the vPars and HPVM support 
matrix.
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Features that are Not Supported

Cloning and migration of virtual machines are not supported by the HPUX Virtualization 
Manager. However, they are supported by HP Integrity Virtual Machines. 

SA Permissions Required

The following SA permissions are required to manage vPars containers and HPUX 
hypervisors. For complete information on permissions, see the SA Administration Guide.

Action/Feature Permissions Required

To manage HP-UX virtual machines, your SA user must either belong to an SA user group 
that has the following action/feature permissions or have the permissions:

Folder Permissions Required

You need access to the SA Library folder containing the HP-UX Virtualization Manager web 
extension to manage HP-UX virtual machines and run the web extension. This web extension 
is located in the SA Library folder /Opsware/Tools/Virtualization Programs. For 
complete information on folder permissions, refer to the SA Administration Guide.

Use the following procedure to assign the required folder permissions to a user:

1 Log in to the SA Client as an administrative user that has permission to set folder 
permissions.

2 In the SA Client, select the Library tab.

3 Select the By Folder tab to display the SA Library folder structure.

4 Navigate to the folder: /Opsware/Tools/Virtualization Programs.

5 Right click Virtualization Programs and select the Folder Properties menu. This displays 
the Folder Properties window.

Table 2 Action/Feature Permissions Required for Managing HP-UX virtual 
servers using SA

Permission Setting User Action Enabled

Feature tab:
Managed Servers and 
Groups

Yes View managed servers and device groups

Client Features tab:
View Virtual Servers

Yes View HPVM hypervisors, HPVMs, vPars 
containers, vPars, and vSwitches

Discover and refresh HPVM hypervisors

Client Features tab:
Manage Virtual Servers

Yes Create, modify, and remove HPVM hypervisors, 
vPars containers, vPars, vSwitches, and 
HPVMs

Client Features tab:
Administer Virtual 
Servers

Yes Shut down, halt, and start HPVMs, vPars, and 
vSwitches
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6 In the Folder Properties window, select the Permissions tab. This displays the user groups 
that have some permissions to the folder.

7 Select the user group you want to grant access to. If the user group does not appear, select 
the Add button to add it.

8 Select Execute Objects Within Folder.

9 Select OK.

Resource Permissions Required

As with all server management tasks, you need access to the HP-UX servers. Grant access to 
the facility, customer and at least one device group of your HP-UX managed servers. For 
complete information on resource permissions, see the SA Administration Guide.

Server and Switch Status Icons

This section describes the icons associated with HPVM hypervisors and vPars containers.

Table 3 describes the vPar container and HPVM hypervisor status icons (displayed in the 
HP-UX Virtualization Manager web extension) and their meaning:

Table 4 shows the vSwitch icons displayed in the HP-UX Virtualization Manager web 
extension and their meanings.

Table 3 Status Icons

Icon
Icon Meaning for vPars 
Containers Icon Meaning for HPVM Hypervisor

Managed

1 or more vPars reachable

Managed and reachable

Managed

Unreachable

Managed, but unreachable

Unmanaged (or HP-UX Virtualization 
Manager web extension not run while 
the server in nPars mode)

1 or more vPars reachable

Not applicable

Unmanaged (or HP-UX Virtualization 
Manager web extension not run while 
the server in nPars mode)

Unreachable

Not applicable

Table 4 vSwitch Icons

Icon Icon Meaning for vSwitches

Status is Up

Status is not Up
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Quick Start vPars, HPVMs, and vSwitches

This section describes prerequisites.

Prerequisites for using HP-UX Virtualization Manager web extensions:

1 Make sure that:

a HP-UX servers are managed by SA and visible in the SA client under Devices > All 
Managed Servers. For more information, see the SA User Guide: Server Automation.

b SA user has adequate permissions. For details, see SA Permissions Required on 
page 5.

Prerequisites for managing vPars, HPVMs, or vSwitches:

1 Manage your vPars as described in Managing vPars Containers on page 16.

2 Manage your HPVMs as described in Managing HPVM Hypervisors on page 21.

3 Manage your vSwitches as described in Managing vSwitches on page 27.

Launching the HP-UX Virtualization Manager

To launch the HPVM manager:

1 In the SA Client, in the left panel, choose Library > Extensions > Web.

2 In the Web panel, double-click the HP-UX Virtualization Manager icon to display the 
HP-UX Virtual Servers window, which lists HPVM hypervisors and vPars containers.

Viewing Summary, Hardware, and ioScan Information

This section describes how to view information for HPVM hypervisors/vPars containers/
HPVMs/vPars, and vSwitches.
Managing HP-UX Virtual Servers Using Server Automation 7



To view information:

1 Follow the steps in Launching the HP-UX Virtualization Manager on page 7 to display the 
HP-UX Virtual Servers window.

2 Double-click HP-UX Virtualization Manager to display the HP-UX Virtual Servers 
window, which contains a list of HPVM hypervisors/vPars containers associated with that 
manager.

To view individual HPVMs/vPars/vSwitches, click the arrow to the left of the HPVM 
hypervisor/vPars container associated with that individual component.
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Table 5 HPVM Hypervisor/vPars Containers/HPVMs/vPars/vSwitches 
Information

Property Description

Name Name, as designated when the HPVM 
hypervisor/vPars container was added to the 
HP-UX Virtualization Manager

Status Status (whether the HPVM hypervisor/vPars 
container is reachable from the SA Client 
core or not)

Status = Unreachable or

Status = vPars (for vPars mode); Physical 
Server (for nPars mode or HPVM) 

For individual vPars and vSwitches, status = 
Up/Down

For individual HPVMs, status = On/Off

Type Whether the HPVM hypervisor or vPars 
container is running the vPars or HPVM 
software

Hostname Hostname of:

— HPVM hypervisor or vPars container

— HPVM or vPars that has become a 
managed server in the SA Client

Note: Hostname = - (dash) if HPVM or vPars 
is not a managed server

IP Address Individual HPVM hypervisor/vPars 
container /HPVM/vPars IP address

Note: Value is blank if HPVM is not an 
SA-managed server

Facility Physical location of the HPVM hypervisor/
vPars container host machine

Customer Assigned customer
Managing HP-UX Virtual Servers Using Server Automation 9



3 To display summary information for a selected HPVM hypervisor/vPars container/HPVM/
vPars/vSwitch, choose View > Summary and then select the HPVM hypervisor/vPars 
container/HPVM/vPars/vSwitch to display its summary information in the bottom 
summary panel.

Summary information includes:

Table 6 Summary Information

Property Description

ID Identification number in the SA Client

Status Status (whether the HPVM hypervisor/vPars 
container/HPVM/vPars/vSwitch is reachable 
from the SA Client core or not)

Status = Unreachable or

Status = vPars (for vPars mode); Physical 
Server (for nPars mode or HPVM) 

For individual vPars and vSwitches, status = 
Up/Down

For individual HPVMs, status = On/Off

Lifecycle Managed by the SA Client or not

Manufacturer Name of the manufacturer

OS Version Version

Serial Serial number
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4 To display hardware information for a selected HPVM hypervisor/vPars container/
HPVMs/vPars, choose View > Hardware.

Hardware information includes:

Table 7 HPVM Hypervisor Hardware Information

Property Description

Available CPUs Number of CPUs assigned

Available CPU speed for an HPVM CPU speed available for HPVMs associated 
with that HPVM hypervisor/vPars container

Total Physical Memory Total physical memory associated with the 
HPVM hypervisors/vPars container

Available memory for a HPVM Memory available for a particular HPVM 
associated with the HPVM hypervisors/
vPars container

Table 8 vPars Container Hardware Information

Property Description

Available CPUs Number of CPUs assigned

Available Interleaved Memory Amount of non-cached memory available to 
the vPars container

Available Cell - Memory Amount of memory available per cell (series 
of comma-separated <cell number>:<memory 
size>)

Available Cell - CPU Indicates the number of CPUs available per 
cell (a series of comma-separated <cell 
number>:<number of CPUs>)
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5 To display information about the devices connected to a selected HPVM hypervisors/vPars 
container/HPVM/vPars machine, such as storage, disk, memory, and processor 
information, choose View > IO Scan.

The IO Scan view shows the output from the HP-UX ioscan(1M) command for the selected 
vPars container or HPVM. 

Table 9 vPars Hardware Information

Property Description

Assigned CPUs Number of CPUs assigned to vPars

Assigned Total Memory Amount of assigned memory for vPars

Cell - CPU Number of available cell CPUs

Cell - Memory Amount of cell memory available

Primary Boot Disk Name of the primary boot disk

Alternate Boot Disk Name of the alternate boot disk

Number of Local Bus Adapter(s) Number of local bus adapters for vPar

Local Bus Adapter(s) Name of the local bus adapters

Table 10 HPVM Hardware Information

Property Description

Assigned CPUs Number of CPUs assigned to HPVM

Assigned Memory Amount of memory assigned to HPVM

Assigned vSwitches vSwitches assigned to HPVM, in a list of 
comma-separated <port> - <HPVM> 
associated with the vSwitch

Assigned Storage Amount of storage assigned to the HPVM

Table 11 vSwitch Hardware Information

Property Description

Assigned LAN interface LAN interface assigned to the vSwitch

Assigned Ports Ports assigned exclusively to the vSwitch
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To rearrange ioScan output columns, drag and drop them. To sort by column, select the 
column header. To sort by additional columns, hold down the Ctrl key while selecting the 
column header.

6 IOScan information (which is applicable only to HPVM hypervisors and vPars containers) 
includes:

Table 12 IO Scan Information

Property Description

Class Device class

Instance Instance

Hardware Path Hardware path to the device

Driver Driver associated with the device

Software State

(of devices attached to the machine)

CLAIMED = device software bound 
successfully

NO-HW = device hardware is no longer 
responding

Description Device description (for example, whether it is 
an adapter or processor)

Device Special Files Device filename (as identified by the system)
Managing HP-UX Virtual Servers Using Server Automation 13



Saving ioscan Output

For vPars, ioscan output can only be obtained when the nPar or physical server is in nPars 
mode. 

The following procedure saves a copy of the ioscan output, makes the output viewable, and 
simplifies the process of creating and modifying vPars. You will need to repeat these steps to 
refresh the ioscan output if you add or remove input/output information.

1 Boot the server to nPars mode.

2 Follow the steps in Launching the HP-UX Virtualization Manager on page 7 to display the 
HP-UX Virtual Servers window.

3 If the server is already displayed on the main page, the ioscan output has been saved.

4 If the server is not displayed, add the server to the main page (see Adding an HPVM 
Hypervisor/vPars Container on page 14).

Adding an HPVM Hypervisor/vPars Container

To add an HPVM hypervisor or vPars container to HP-UX Virtualization Manager 
management:

1 Follow the instructions in Launching the HP-UX Virtualization Manager to display the 
HP-UX Virtual Servers window.

2 In the HP-UX Virtual Servers window, select the HPVM hypervisor to associate with the 
new HPVM.

3 Click .

The Add Virtual Servers window is displayed.
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4 In the Virtual Servers window, choose the following HPVM search criteria (you can use 
wildcards to search):

5 Click Search.

6 In the results field, select the HPVM(s) to be added.

7 Click Add Server to add the HPVM.

The new HPVM is added as a managed server in the list below its associated HPVM 
hypervisor/vPars container.

Configuring Server Timeouts

SA verifies connectivity with HP-UX virtual servers by pinging them. If a server is offline, the 
ping will time out and the server will be considered offline. By default the ping timeout value 
is 15 seconds. You can reduce the ping timeout and improve responsiveness on networks with 
low latency by setting the value of the custom attribute hpux_v12n_timeout.

You can configure the timeout value by setting a custom attribute named 
hpux_v12n_timeout. The default value is 15 seconds. You can set it to any integer from 1 to 
120.

For each server, SA searches the following objects in order for the custom attribute:

1 Server

2 Device group

3 Customer

4 Realm

5 Facility

6 OS

7 Software policy

Table 13 Add Virtual Servers Search

Field Choice Displays

Main field

All All servers (including 
managed and virtual)

Explicit IPs/Hostname HPVM hypervisors by their 
IP address or hostname

Supply IP Address Range HPVMs within an IP address 
range

Search in All Facilities HPVMs at all facilities

<specific facility 
choice>

HPVMs at the specified 
facility

Display Virtual Servers only Only HPVMs

All Servers
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For example, if you add the hpux_v12n_timeout custom attribute to the device group named 
“HP-UX 11.31”, all HP-UX 11.31 servers inherit that timeout value, unless they explicitly set 
the custom attribute at the server level.

Or to change the timeout value for all the servers that reside in a particular facility, add the 
custom attribute to that facility.

For more information on custom attributes, see the SA User Guide: Server Automation.

Custom Attributes that HP-UX Virtualization Manager Creates

The HP-UX Virtualization Manager creates the following custom attributes for internal 
management:

Managing vPars Containers

You can only create, use, and manage vPars containers on managed servers. See the SA User 
Guide: Server Automation for instructions on how to make a server a managed SA server.

Your HP-UX server must be in nPars mode or in vPars mode to use the HP-UX Virtualization 
Manager. You must use HP-UX commands and tools to switch between nPars mode and vPars 
mode. For more information, see the HP-UX Virtual Partitions documentation.

The following sections describe how to manage HP-UX virtual partitions. You can perform any 
of these operations on any vPars as long as at least one vPar in the vPar container is a 
managed server and is online.

Switching between nPars and vPars modes

To switch between nPars and vPars from the HP-UX shell:

Set the mode for the next nPartition reboot:

# vparenv [-m mode]

Table 14  HP-UX Virtualization Manager Custom Attributes

vPars/HPVM Attribute Value Description

vPars ioscan String 
(JSON format)

ioscan command output 
(enables server to be displayed 
in vPars mode)

vPars nPar True True = server reboots while in 
nPars mode

vPars

HPVM

partition_ident:
<value>

True Partition identifier (identifies 
which servers are on the same 
partition)

vPars sa_vPars_hypervisor True True = server displayed on the 
HPUX Virtualization Manager 
main page

vPars vpar_name String Server’s vPars name.
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Where mode has the value of either vPars or nPars. This action might take a few minutes to 
process.

For example:

a Set the mode:

# vparenv -m vPars

a Manually reboot the nPartition:

# shutdown -r
...
Shell> fs0:
fs0:\> hpux/stand/vpmon
...
MON>

To switch between nPars and vPars from the vPars monitor:

Reboot the nPartition into the mode mode:

reboot [mode]

Where mode is either vPars or nPars.

If any virtual partitions are up, issuing this command will cause them to be shutdown 
ungracefully.

To switch from the EFI, issue the following command:

Shell> fs0:
fs0:\. vparconfig reboot [mode]

Where mode is either vPars or nPars.

Creating a vPar

To create an HP-UX vPars virtual partition, perform the following steps.

1 Run the HP-UX Virtualization Manager as described in Launching the HP-UX 
Virtualization Manager on page 7.

2 Select an HP-UX server that is a vPars Container.

3 Right click on the HP-UX server and select Create vPar. This displays the Create Virtual 
Partition window as shown below.
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Figure 1 Create Virtual Partition Screen

4 Select the General tab and enter the vPars General settings:

5 Select the CPU tab and enter the CPU settings:

Table 15 vPars General Settings

Property Description

vPars name Name, as designated when the vPars 
container was added to the HP-UX 
Virtualization Manager

vPar Boot Disk Setting Setting to automatically or manually boot 
the disk

Use the primary boot only or have alternate 
boot available.

Advanced Settings - Kernel path and 
Kernel Boot Options

Full kernel path and kernel boot options 
(optional)
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Select the Memory tab and enter the memory settings:

Table 16 vPars CPU Settings

Property Description

CPU Number of CPUs to be allocated to the vPars

If the server is in nPars mode, the total 
available CPUs, remaining CPUs, number of 
cells and the default maximum number of 
CPUs are unknown.

The number of allocated CPUs must fall 
within the 'CPU Minimum'/'CPU Maximum' 
range.

A total of 16 cells will always be displayed in 
the table. 

Minimum Number of CPUs Minimum number of CPUs to allocate to the 
vPars

Maximum Number of CPUs Maximum number of CPUs to allocate to the 
vPars (default: 256)

Table 17 vPars Memory Settings

Property Description

Base Memory Amount of base memory to allocate to the 
vPars

If the server is in nPars mode, the 
Remaining Available memory and the 
number of cells are unknown.

A total of 16 cells will always be displayed in 
the table. 

Floating Memory Amount of floating memory to allocate to the 
vPars

Cell Local Memory Amount of cell local memory to allocate to 
the first vPars (optional)

Inter Leaved Memory Amount of inter-leaved memory to allocate to 
the first vPars (optional)
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Select the Input/Output tab and set the I/O settings for the vPar:

If ioScan data is not available, the Available Hardware Inventory panel will be blank.

6 Click Submit to create the vPar virtual partition.

Modifying a vPar

To modify a vPar, right click on a vPar and select Modify vPar. The Modify vPar window is 
generally the same as the Create vPar except that the current values of the vPar are filled in, 
and the memory and I/O settings cannot be modified if the vPar's status is Up.

This APX will make multiple calls to the vparmodify command to modify the vPar as needed. 
So while the vparmodify command has restrictions on the number of things that can be 
modified per command invocation, this APX does not.

Starting a vPar

To start a vPar, right click on the vPar and select Start vPar. (Starting a vPar invokes the 
vparboot command, which always attempts to boot an OS from the primary boot disk 
regardless of the autoboot settings.)

Shutting Down a vPar

To gracefully shut down a vPar, right click the vPar and select Shutdown vPar. This runs the 
HP-UX shutdown(1M) command on the vPar. This operation is only available when the vPar 
is an SA managed server and the status is Up.

Halting a vPar

To forcefully halt a vPar, right click the vPar and select Halt vPar. This runs the HP-UX 
vparreset -f -h command to halt the vPar. This operation is only available when the vPar 
status is Up.

Table 18 vPars Input-Output Settings

Property Description

Primary boot disk Path to the primary boot disk 

(You must type in the full hardware path of 
the disk or logical box (LBA).)

Alternate boot disk Path to the alternate boot disk (optional)

(You must type in the full hardware path of 
the disk or logical box (LBA)).

Local bus adapter Name of the local bus adapter

Advanced setting: Kernel Path Kernel path

Advanced setting: Kernel Boot Kernel boot options
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Deleting a vPar

A vPar that is not in Up status can be deleted. To delete a vPar, right click on the vPar and 
select Delete vPar. This option is also available on the right click menu of a vPar.

Managing HPVM Hypervisors

This section describes how to create, add, delete, and modify HPVM hypervisors and HPVMs 
using the HP-UX Virtualization Manager.

To manage HPVMs using the web-extension, the HPVM host must be a managed server in 
Server Automation. For instructions on how to convert HPVMs into managed servers, see the 
SA User Guide: Server Automation.

Creating an HPVM

To create an HPVM:

1 Follow the instructions in Launching the HP-UX Virtualization Manager.

1 In the HP-UX Virtual Servers window, right-click an HPVM hypervisor.

2 Choose Create VM to display the Create Virtual Machine window.
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3 Enter the following information for the new HPVM (You can create a new HPVM by just 
entering a name and accepting the defaults.):

Table 19 Create VM

Tab and Section
Field or 
Button Choice

Description and Default 
Setting

General

General Name HPVM name

(Can include up to 256 
upper or lower case 
alphanumeric characters; 
dash (—); underscore (_), 
and period (.))

Note: Cannot start with a 
dash

(Required)

Default: 
NewVirtualMachine.

Description HPVM description.

(Can include up to 256 
upper or lower case 
alphanumeric characters; 
dash (—); underscore (_), 
and period (.))

Operating 
System will 
be HP-UX

Whether the HP-UX 
operating system be 
installed on this VM

Note: Installing the HP-UX 
operating system is not part 
of creating an HPVM. 

Default: Not selected.

When the 
host machine 
powers up, 
the HPVM 
should 
start:

Automatically Starts when host powers up

Default: Automatically.

Manually Start HPVM manually

CPU

Desired CPUs Number of 
CPUs

1 - 256 Number of CPUs dedicated 
to the HPVM

Default: 1
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Entitlement

(click  to 
display choices)

Specify 
Processing 
Power

%Utilization:

• Minimum

• Maximum

% of each CPU to be used for 
the HPVM

% Utilization maximum 
must be >= % utilization 
minimum

Defaults: Minimum: 10; 
Maximum: 100

CPU Cycles

• Minimum

• Maximum

Number of CPU cycles 
(Mega Hertzs or Giga 
Hertzs)

Minimum number cannot be 
> maximum number

Maximum number cannot > 
CPU cycles available on 
system 

Memory

Desired Memory Memory MegaBytes (MB) of memory 
allocated to HPVM

Default: 512

Dynamic Memory 
Control

(click  to 
display choices)

Use dynamic 
memory 
control

Required: Checked Dynamic 
Memory Control box

Default: Disabled.

Initial 
Target 
Memory Size

Initial memory that 
dynamic memory driver 
tries to access when guest 
starts

Required: Checked Dynamic 
Memory Control box

Minimum 
Memory Size

Minimum memory available 
to be dynamically allocated 
to guest

Required: Checked Dynamic 
Memory Control box

Maximum 
Memory Size

Maximum memory 
available to be dynamically 
allocated to guest 

Required: Checked Dynamic 
Memory Control box

Table 19 Create VM

Tab and Section
Field or 
Button Choice

Description and Default 
Setting
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Virtual Networks List of vSwitches associated 
with HPVM

Defined Virtual 
Network - Add 
Virtual Switch

(click Add Virtual 
Switch to display 
choices)

vSwitch information for 
existing vSwitches

Network 
Adapter Type

LAN

AVIO-LAN

LAN or AVIO-LAN to 
associate with the vSwitch

Default: LAN

Network 
Interface 
Card

Any available

PCI Bus (0 - 7)

PCI Device (0-7)

Type of interface card to 
associate with the vSwitch

Default: Any available PCI 
bus or device (recommended 
choice)

Select a 
vSwitch

vSwitches available to 
associate with the HPVM

Note: Select the switch and 
click Done to add the switch 
to the list.

vSwitch Display Columns

(these criteria are for display purposes only)

Name vSwitch name

Status vSwitch status (Up or 
Down)

Type Shared or 
Exclusive

vSwitch type (shared with 
another HPVM or exclusive)

Number of 
HPVMs using 
vSwitch

Number of HPVMs that 
share the vSwitch

Network 
Adapter Type

LAN

AVIO-LAN

LAN 

AVIO-LAN

PCI Bus Peripheral Component 
Interconnect Bus (PCI Bus) 
associated with the vSwitch

Table 19 Create VM

Tab and Section
Field or 
Button Choice

Description and Default 
Setting
24 Chapter 1



4 Click Submit to create the HPVM and add it to the list.

Modifying HPVMs

To modify HPVM information:

1 Follow the instructions in Launching the HP-UX Virtualization Manager.

2 In the HP-UX Virtual Servers window, right-click an HPVM.

3 Choose Modify VM.

PCI Device Peripheral Component 
Interconnect Device (PCI 
Device) associated with the 
vSwitch

Virtual Storage

Virtual Storage

(click  to 
display choices)

Information about virtual 
storage associated with the 
HPVM

Add Virtual 
Storage

Storage Type Emulated Small 
Computer 
System Interface 
(SCSI)

AVIO Storage

Type of storage to associate 
with HPVM

Default: Emulated SCSI

Virtual 
Device

Disk

Dvd

Virtual device to associate 
with HPVM

Default: Disk

Backing 
Store

Disk

Logical Volume

File System

Type of backing store to 
associate with the HPVM

Default: Disk

Device 
Special File 
(DSF) 
Addressing 
(for disk 
backing 
only)

Agile

Legacy

Type of storage device file 
addressing

Default: Agile

Select a 
Device (for 
disk backing 
only)

Device File/
Logical Volume

Type of Device

Note: Select a device from 
the list and click Done to 
add the device to the list.

Table 19 Create VM

Tab and Section
Field or 
Button Choice

Description and Default 
Setting
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4 Change HPVM settings (see Creating an HPVM for more information on the settings).

Note: Modify VM has a setting that is not available in the Creating HPVM function: 

Advance Settings > Forced Configuration.

Choosing this setting will force the system to make configuration changes and suppress 
all resource conflict checks and associated warning messages. 

Note: If you choose this setting, there will be no notification of potential resource 
problems for a virtual machine that is modified with this option.

5 Click Submit to save the modifications.

Starting an HPVM

To start an HPVM:

1 Follow the instructions in Launching the HP-UX Virtualization Manager.

2 In the HP-UX Virtual Servers window, right-click an HPVM.

3 Choose Start VM.

For information about operating system installation, go to the HP Integrity Virtual Machines 
Installation, Configuration, Administration Guide at: http://docs.hp.com/hpux/11iv3, then 
choose: HP Virtualization Software > HP Integrity Virtual Machines and Online VM 
Migration.

Halting an HPVM

To halt an HPVM:

1 Follow the instructions in Launching the HP-UX Virtualization Manager.

2 In the HP-UX Virtual Servers window, right-click an HPVM.

3 Choose Halt VM.

Note: Halting an HPVM temporarily stops it from performing its functions and allows the 
manager to reallocate resources assigned to it.

Shutting Down an HPVM

1 Follow the instructions in Launching the HP-UX Virtualization Manager.

2 In the HP-UX Virtual Servers window, right-click an HPVM.

3 Choose Shutdown HPVM.

Choosing shutdown means that the HPVM shuts down within 30 seconds. If the time-out 
period expires before the shutdown occurs, a hard stop occurs.

Note: Shutting down an HPVM takes the machine offline and allows the manager to 
reallocate resources assigned to it.
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Removing or Deleting an HPVM

To remove or delete an HPVM from HP-UX Virtualization Manager control:

1 Follow the instructions in Launching the HP-UX Virtualization Manager.

2 In the HP-UX Virtual Servers window, right-click an HPVMs to delete.

3 Choose Delete VM, and click OK when asked to confirm the deletion.

4 The HPVM is deleted from the list of managed servers.

Managing vSwitches

This section describes how to create, modify, and delete a vSwitch.

Note: HP-UX Virtualization Manager manages vSwitches. To view HPVM/vSwitch settings, 
go to the HP Integrity Virtual Machines Installation, Configuration, Administration Guide at: 
http://docs.hp.com/hpux/11iv3, then choose: HP Virtualization Software > HP Integrity 
Virtual Machines and Online VM Migration. For instructions on how to configure LANs and 
VLANs, see LAN/VLAN documentation. 

Creating a vSwitch

To create a vSwitch:

1 Follow the instructions in Launching the HP-UX Virtualization Manager.

2 In the HP-UX Virtual Servers window, right-click an HPVM hypervisor.

3 Choose Create vSwitch to display the Create vSwitch window.
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4 Enter the following information for the new vSwitch:

Modifying a vSwitch

To modify vSwitch information:

1 Follow the instructions in Launching the HP-UX Virtualization Manager to access the 
HP-UX Virtual Servers window.

2 In the HP-UX Virtual Servers window, right-click a vSwitch.

3 Choose Modify vSwitch.

4 Change vSwitch settings.

The fields that cannot be modified will not be enabled.

Starting a vSwitch

To start a vSwitch:

1 Follow the instructions in Launching the HP-UX Virtualization Manager to access the 
HP-UX Virtual Servers window.

2 In the HP-UX Virtual Servers window, right-click a vSwitch.

3 Choose Start vSwitch.

Table 20 Create vSwitch

Field/Button Description

Name Choose a name for the vSwitch that does not exceed 
eight (8) characters.

Default: Switch1

Type Sharable (shared with other HPVMs) or dedicated 
(associated only with this HPVM)

Default: Shareable

Create a local virtual 
switch, OR

Select a LAN interface to 
connect to (must select the 
LAN from the list)

Local switch that is not connected to another device.

LAN to connect to (Default)

Start the virtual switch 
after creating

Starts the vSwitch immediately after it is created.

Default: Not selected
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Stopping a vSwitch

To stop/halt a vSwitch:

1 Follow the instructions in Launching the HP-UX Virtualization Manager to access the 
HP-UX Virtual Servers window.

2 In the HP-UX Virtual Servers window, right-click a vSwitch.

3 Choose Stop vSwitch.

Note: Halting or stopping a vSwitch temporarily stops it from performing its functions and 
allows the manager to reallocate resources assigned to it.

Removing or Deleting a vSwitch

To remove or delete a vSwitch from HP-UX Virtualization Manager control:

1 Follow the instructions in Launching the HP-UX Virtualization Manager to access the 
HP-UX Virtual Servers window.

2 In the HP-UX Virtual Servers window, right-click a vSwitch to delete.

3 Choose Delete vSwitch, and click OK when asked to confirm the deletion.

Configuring vLAN Connections

To configure vLAN connections:

1 Follow the instructions in Launching the HP-UX Virtualization Manager.

2 In the HP-UX Virtual Servers window, right-click a vSwitch.

3 Choose Configure VLAN.

4 For each HPVM, choose the corresponding VLAN ID. 

Troubleshooting

This section explains how to troubleshoot your HP-UX virtualization feature.

The HP Support web site provides contact information and details about the products, 
services, and support that HP Software offers. 

For more information or to get help with your issue, contact HP Support: 

http://www.hp.com/managementsoftware/support

Troubleshooting Issues

Problem: The HP-UX Virtualization Manager extension is not displayed in the SA Library.

• Make sure your user has permission to view and execute the web extension. For details, 
see Folder Permissions Required on page 5.
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Problem: When adding virtual servers, an HP-UX server does not appear in the search 
results. Or, when searching all servers, the server displays but when searching for specific IP 
addresses, it does not.

• Set the Display drop-down list to All Servers and search again.

• Ensure the server is a managed server. For more information, see the SA User Guide: 
Server Automation.

• Perform a hardware registration. On the managed server, run the following SA command:

/opt/opsware/agent/pylibs/cog/bs_hardware

Problem: When adding virtual servers, a particular server only shows in the results when 
display is set to All Servers.

• Ensure either Virtual Partition or HP VM software is installed on the server

• Perform a software registration. On the managed server, run the following SA command:

/opt/opsware/agent/pylibs/cog/bs_software

Problem: The Summary view for a server does not display all information about the server.

• If the server is not managed by SA, some information may not be displayed. Bring the 
server under SA management. For instructions, see the SA User Guide: Server 
Automation.

• If the server is a managed server, perform a hardware registration. On the managed 
server, run the following SA command:

/opt/opsware/agent/pylibs/cog/bs_hardware

Checking Log Files

Log files are stored in the user’s /tmp directory in the Global File System (OGFS). To access 
them, log in to the OGSH and change directory to /tmp.

The name of the log file for HP-UX virtualization is hpuxvirtlog. This is a rotating log file, so 
over time you will see hpuxvirtlog.1 and hpuxvirtlog.2 up to a maximum of 3 log files. The 
current log file is always hpuxvirtlog. The file rotates when the size reaches 5Mb.

The log file shows informative messages, warnings and errors. The informative messages 
show the vPars and HP VM commands that are executed on the managed servers.

Nearly all errors and warnings are displayed in the HP-UX Virtualization manager, so 
checking the log files is usually not necessary.
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Example Log Messages

Here are example log messages:

2011-05-31 10:53:59 INFO HPUX-V12N(127): Requested operation: modify_virtual_machine

2011-05-31 10:54:00 INFO HPUX-V12N.vpar(416): dhcp-184-241: scanning

2011-05-31 10:54:03 INFO HPUX-V12N.vpar(462): /usr/sbin/vparmodify -p vpar2 -m 
cell:1:cpu::1

Returned: 0

2011-05-31 10:54:03 INFO HPUX-V12N.vpar(462): /usr/sbin/vparmodify -p vpar2 -B search

Returned: 0

The messages include the date, time, log level (INFO), module (HPUX-V12N and 
HPUX-V12N.vpar), and the message text. The lines above show a modify operation performed 
on a vPar (vpar2). The modify commands were executed on server dhcp-184-241 and both 
commands returned 0, meaning they were successful.
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